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BAB III 

METODE PENELITIAN 

A. Desain Penelitian 

Suatu metode diperlukan dalam setiap penelitian. Penggunaan 

metode dalam penelitian disesuaikan dengan masalah dan tujuan yang akan 

diteliti. Hal ini berarti metode penelitian mempunyai kedudukan yang penting 

dalam pelaksanaan pengumpulan dan analisis data. Mengacu pada penelitian 

ini maka metode penelitian yang penulis pilih dan tetapkan yaitu metode 

eksperimen. Rancangan eksperimental adalah pendekatan tradisional untuk 

melaksanakan penelitian kuantitatif (Creswell, 2015). 

Penelitian kuantitatif adalah definisi, pengukuran data kuantitatif dan statistik 

objektif melalui perhitungan ilmiah berasal dari sampel orang -orang yang 

menjawab atas sejumlah pertanyaan tentang survei untuk menentukan 

frekuensi dan persentase tanggapan mereka. Dalam penelitian ini pen eliti 

menggunakan eksperimen dengan pretest-posttest control group design.  

 

 

    

 

    

 

 

Gambar 3.4 

Desain Penelitian 

(Creswell, 2015) 

Keterangan : 

O1, O3  = Pre-test atau tes awal  

O2, O4 = Post-test atau tes akhir  

T1            = Program integrasi liife skills 

Kel A       = Kelompok kontrol pada klub olahraga tanpa pemberian 

muatan  

    life skills 

Kel B     = Kelompok eksperimen pada klub olahraga dengan 

pemberian  

 O1                                            O2 Kel A 

 O3                                   T1                     O4 Kel B 
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    muatan life skills 

 

B. Partisipan 

Partisipan yang terlibat dalam penelitian ini adalah remaja berusia 

13-15 tahun, dibagi menjadi tiga kelompok, yaitu anak yang mengikuti 

aktivitas di klub olahraga, dan anak yang sama sekali tidak mengikuti 

aktivitas di klub olahraga. Jumlah partisipan secara keseluruhan adalah 76 

orang. 

 

C. Populasi dan Sampel  

Dalam menentukan populasi dan sampel, diperlukan ketelitian dari 

peneliti untuk menemukan individu yang sesuai dengan tujuan dari 

penelitian. Populasi merupakan sekelompok subjek yang dijadikan sumber 

data, baik benda, manusia, gejala ataupun peristiwa yang sesuai dengan 

permasalahan   yang   diteliti. Arikunto (2013) menjelaskan sebagai berikut. 

“Populasi adalah keseluruhan subjek penelitian. Apabila seseorang ingin 

meneliti semua elemen yang ada dalam wilayah penelitian, maka 

penelitiannya merupakan penelitian populasi.”  

Sesuai dengan permasalahan penelitian, maka yang menjadi 

populasi dalam penelitian ini adalah remaja yang mengikuti klub olahraga 

yang ada di Kabupaten Ciamis. Sampel ditentukan dengan cara purposive 

sampling yaitu salah satu teknik sampling non random sampling dimana 

peneliti menentukan pengambilan sampel dengan cara menetapkan ciri-ciri 

khusus yang sesuai dengan tujuan penelitian sehingga diharapkan dapat 

menjawab permasalahan penelitian.  

Berdasarkan penjelasan purposive sampling tersebut, ada dua hal 

yang sangat penting dalam menggunakan teknik sampling tersebut, yaitu non 

random sampling dan menetapkan ciri khusus sesuai tujuan penelitian oleh 

peneliti itu sendiri. Non random sampling adalah teknik sampling yang tidak 

memberikan kesempatan yang sama pada set iap anggota populasi untuk 

dijadikan sampel penelitian. Sedangkan ciri khusus sengaja dibuat oleh 

peneliti agar sampel yang diambil nantinya dapat memenuhi kriteria -kriteria 

yang mendukung atau sesuai dengan penelitian. Berdasarkan pemaparan 

tersebut, maka sampel dalam penelitian ini yaitu anak usia 13-15 tahun yang 
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mengikuti klub olahraga sepakbola di Kabupaten Ciamis dan anak usia 13-

15 tahun yang sama sekali tidak terlibat dengan kegiatan olahraga di 

Kabupaten Ciamis. 

Secara garis besar sampel dibagi mejadi dua kelompok, yaitu anak 

yang aktif dalam aktivitas klub olahraga dan yang sama sekali tidak 

mengikuti aktivitas dalam klub olahraga. Untuk lebih jelasnya, sampel dari  

klub olahraga yang diberikan muatan life skills adalah anggota SSB Fortuna 

dengan usia 13-15 sebanyak 25 orang, sampel dari  klub olahraga yang tidak 

diberikan muatan life skills adalah anggota SSB Bonansa dengan usia 13-15 

sebanyak 23 orang dan sampel yang tidak mengikuti klub olahraga adalah 

siswa-siswi SMP Manarul Huda dengan jumlah sampel sebanyak 28 orang. 

 

 

 

D. Instrumen Penelitian 

Dalam penelitian ini, data dikumpulkan dengan menggunakan skala 

Life Skills Scale For Sport (LSSS) yang dikembangkan oleh Cronin & Allen, 

(2017). Instrumen LSSS diperuntukan bagi partisipan olahraga remaja yang 

berusia antara 11 sampai 21 tahun. Intsrumen LSSS berisi delapan 

keterampilan hidup dengan 47 item pertanyaan tertutup. Rentang skala yang 

digunakan adalah skala 5 poin, yaitu 1 (not at all) hingga 5 (very much). 

Sesuai dengan rekomendasi dari Cronin & Allen, (2017)  yang menyatakan 

bahwa meskipun sebagian besar bukti dari 1-4 mendukung validitas dan 

reliabilitas LSSS, penting untuk menekankan kembali  bahwa validitas dan 

reliabilitas dianggap sebagai proses yang berkelanjutan, dengan demikian 

studi masa depan harus memberikan bukti lebih lanjut untuk validitas dan 

reliabilitas skala. 

 

E. Prosedur Penelitian 

1. Tahap Persiapan 

Tahap ini diawali dengan studi pendahuluan ke lapangan. Studi 

pendahuluan bermaksud untuk mengetahui populasi, sampel, serta lokasi 

penelitian. Setelah melakukan studi pendahuluan peneliti meneruskan 

dengan mengurus berbagai perizinan penelitian dari dalam kampus serta dari 
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luar kampus. Setelah melakukan serangkaian perizinan, peneliti mulai 

membuat instrument terkait dengan kedua variabel tersebut.  

2. Tahap Pelaksanaan 

Setelah diperoleh data dari studi pendahuluan, langkah selanjutnya 

yaitu melakukan tes pada setiap sampel. Pelaksanaan tes ini dilakukan untuk 

mendapatkan data yang akan digunakan dalam penelitian, kemudian 

dianalisis dan diolah sesuai dengan  prosedur dan teknik pengolahan data  

yang berlaku,  sehingga diperoleh hasil untuk ditarik suatu kesimpulan. 

 

3. Teknik Pengumpulan Data 

Pengumpulan data merupakan langkah  yang sangat penting 

dalam penelitian karena akan menentukan langkah penelitian selanjutnya. 

Dalam proses pengumpulan data seorang peneliti harus didasarkan pada 

metode dan teknik pengumpulan data yang tepat sesuai dengan masalah yang 

diteliti serta didukung dengan alat pengumpulan data yang relevan, sehingga 

dapat diperoleh data yang objektif sesuai dengan kondisi di lapangan. Dalam 

penelitian ini, data dikumpulkan dengan menggunakan skala  Life Skills Scale 

For Sport (LSSS) yang dikembangkan oleh Cronin & Allen, (2017). Tes yang 

dilakukan hanya sekali tersebut bisa memberikan penilaian terhadap 

kemampuan siswa dalam variabel yang penulis teliti.  

 

4. Proses Pengembangan Instrumen  

Berdasarkan rekomendasi Cronin & Allen, (2017) yang 

menekankan untuk melakukan pengujian kembali. Penulis terlebih dahulu 

harus melakukan uji coba instrumen LSSS sebelum disebarluaskan kepada 

sampel yang sebenarnya. Uji coba ini bermaksud untuk mengukur sampai 

sejauh mana tingkat validitas dan reabilitas, sehingga diperoleh sebuah 

instrumen yang memenuhi syarat dan dapat dipergunakan sebagai alat yang 

objektif .  

Instrumen dalam suatu penelitian haruslah memiliki kualitas yang 

benar-benar dapat dipercaya sesuai dengan standar penelitian. Pengujian 

tingkat validitas dan reabilitas dapat dijelaskan sebagai berikut: 

a. Validitas  



37 

 

Isna Daniyati Nursasih, 2018 

DAMPAK AKTIVITAS DALAM KLUB OLAHRAGA TERHADAP LIFE SKILLS 

Universitas Pendidikan Indonesia | repository.upi.edu | 

perpustakaan.upi.edu 

      Syarat pokok suatu instrumen penelitian adalah validitas dan  

reliabilitas. Validitas adalah suatu derajat ketepatan instrumen (alat ukur), 

maksudnya apakah instrumen yang digunakan betul-betul tepat untuk 

mengukur apa yang akan diukur. Untuk mengetahui tingkat validitas dari 

butir soal, digunakan rumus validitas dengan bantuan Statistical Package 

For Social Science (SPSS) dengan cara sebagai berikut: 

1) Buka program SPSS klik Variable View, selanjutnya pada bagian 

Name tulis no dan skor total. 

2) Decimals diubah semua menjadi angka 0. 

3) Setelah itu, klik Data View dan masukkan semua data dari skala. 

4) Selanjutnya dari menu utama SPSS, pilih menu Analyze klik 

Correlate dan klik Bivariate. 

5) Muncul kotak dialog dengan nama Bivariate Correlations 

masukkan semua variabel pada kotak dialog yang satu lagi dengan 

memilih semua variabel dan klik tanda panah. 

6) Pada Correlation Coefficients pilih Perason, lalu untuk untuk kolom 

Test of Significant pilih Two-tailed dan centang pada Flag 

significant Correlations. 

7) Klik Ok. 

8) Setelah selesai, maka akan muncul tampilan output SPSS dan 

diinterpretasikan. 

a). Berdasarkan nilai signifikan, r tabel = jumlah responden dan nilai 

signifikansi 5%. 

Jika nilai r hitung > r tabel, maka soal tersebut dinyatakan valid. 

Jika nilai r hitung < r tabel, maka soal tersebut dinyatakan tidak 

valid. 

b). Berdasarkan tanda bintang SPSS. 

Jika terdapat tanda bintang pada nilai dalam hasil output, berarti 

terdapat korelasi yang signifikan antara variabel yang dihubungkan. 

 

b. Reliabilitas 

      Instrumen yang baik adalah instrumen yang dapat ajeg memberikan  

data yang sesuai dengan kenyataan. Arikunto (2013), “reliabilitas suatu tes 

adalah ketetapan suatu tes apabila diteskan kepada subjek yang sama.” Untuk 



38 

 

Isna Daniyati Nursasih, 2018 

DAMPAK AKTIVITAS DALAM KLUB OLAHRAGA TERHADAP LIFE SKILLS 

Universitas Pendidikan Indonesia | repository.upi.edu | 

perpustakaan.upi.edu 

mengetahui tingkat validitas dari butir soal, digunakan  rumus reliabilitas 

dalam SPSS dengan cara sebagai berikut : 

1) Buka program Statistical Package For Social Science (SPSS)  klik 

Variable view, selanjutnya pada bagian Name tulis nomor soal. 

2) Decimals diubah semua menjadi angka 0. 

3) Setelah itu, klik Data View dan masukkan semua data dar skala. 

4) Selanjutnya dari menu utama SPSS, pilih menu Analyze klik Scale 

dan Reliability. 

5) Muncul kotak dialog dengan nama Reliability Analysis masukkan 

semua variabel kecuali skor total pada kotak dialog yang satu lagi 

dengan memilih semua variabel dan klik tanda panah. 

6) Klik Statistics dan centang Scale if item deleted. 

7) Klik Continue, lalu klik Ok untuk mengahiri perintah. 

8) Setelah selesai, maka akan muncul tampilan output SPSS dan 

diinterpretasikan. Lihat nilai alpha yang muncul pada hasil output 

SPSS, lalu bandingkan dengan r tabel, ( r tabel = n dan nilai 

signifikansi 5%). 

Jika nilai alpha > r tabel, maka instrumen tersebut dinyatakan 

reliabel. 

Jika nilai alpha < r tabel, maka instrumen tersebut dinyatakan tidak 

reliabel. 

 

5. Batasan Penelitian 

Untuk memberikan tujuan yang jelas dalam penelitian ini, maka 

batasan dalam penelitian ini adalah sebagai berikut: 

a. Terdapat dua variabel dalam penelitian ini, yaitu variabel life skills dan 

aktivitas klub olahraga. 

b. Sampel yang diambil adalah anggota klub olahraga yang aktif 

mengikuti kegiatan dengan rentang usia 13 sampai dengan 15 tahun. 

c. Sampel yang diambil adalah anak yang tidak aktif  mengikuti kegiatan 

dengan dalam klub olahraga rentang usia 13 sampai dengan 15 tahun. 

d. Penelitian dilakukan dengan desain pretest-posttest control group 

design. 
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6. Definisi Operasional 

Untuk memberikan pengertian yang jelas dalam penelitian ini, maka 

definisi operasional dalam penelitian ini adalah sebagai berikut: 

a. Life skills. Cronin & Allen, (2017) megemukakan pendapat bahwa life 

skills ini meliputi kerjasama tim, penetapan tujuan, manajemen waktu, 

keterampilan emosional, komunikasi interpersonal, keterampilan sosial, 

kepemimpinan, dan pemecahan masalah dan pengambilan keputusan. 

Menurut Danish mendefinisikan life skills sebagai suatu keterampilan 

yang memungkinkan individu mampu berhasil di lingkungan yang 

berbeda dari tempat mereka tinggal, seperti sekolah, rumah dan 

lingkungan mereka. 

Life skills yang dimaksud dalam penelitian ini adalah keterampilan 

yang memungkinkan anak mampu berhasil dalam berbagai lingkungan 

yang berbeda meliputi 8 kompenen kecakapan yaitu kerjasama tim, 

penetapan tujuan, manajemen waktu, keterampilan emosional, 

komunikasi interpersonal, keterampilan sosial, kepemimpinan, dan 

pemecahan masalah dan pengambilan keputusan yang dilakukan pad a 

anak yang mengikuti klub olahraga dan anak yang sama sekali tidak 

mengikuti klub olahraga, diukur dengan skala life skills scale for sport.  

b. Klub Olahraga merupakan kegiatan informal, fleksibel dan terbuka 

(Mendelson et al., 2010). Klub olahraga ini merupakan suatu 

perkumpulan yang menyelenggarakan kegiatan di bidang olahraga bagi 

para anggotanya. 

Klub olahraga yang dimaksud dalam penelitian ini adalah klub 

olahraga sepak bola yang berada di Kabupaten Ciamis dengan peserta 

yang digunakan adalah anggota klub sepak bola yang dengan rentang 

usia 13 sampai dengan 15 tahun. Salah satu dari klub olahraga sepak 

bola ini diberikan program integrasi life skills sesuai dengan komponen 

dalam skala life skills scale for sport.  

 

 

 

 

 



40 

 

Isna Daniyati Nursasih, 2018 

DAMPAK AKTIVITAS DALAM KLUB OLAHRAGA TERHADAP LIFE SKILLS 

Universitas Pendidikan Indonesia | repository.upi.edu | 

perpustakaan.upi.edu 

 

 

7. Jadwal Penelitian 

Agar penelitian terlaksana dengan baik, jadwal dari penelitian yang 

akan ditempuh dalam pelaksanaan penelitian adalah sebagai berikut: 

 

Tabel 3.2 

Jadwal Penelitian 

 
 

F. Analisis Data 

Pada analisis data, penelitian ini menggunakan cara kuantitatif 

dengan statistik deksriptif dan inferensial. Tabulasi data menggunakan Excel 

2013, pada tahap ini akan diketahui rata-rata dan simpangan baku dari data. 

Selanjutnya untuk menentukan data berdistribusi normal atau tidak, maka 

diadakan uji normalitas dan uji homogenitas dengan bantuan Statistical 

Package For Social Science (SPSS). Peneliti berdasarkan tujuan penelitian 

yang ingin dicapai maka dalam proses analisis data akan menggunakan 

statistik inferensial parametris berupa tes uji normalitas, uji homogenitas, uji 

t, uji 2 related samples, uji Kruskall Wallis dan uji Duncan. 

 

1. Uji normalitas data 
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Uji normalitas digunakan untuk mengetahui dan menentukan  teknik 

statsitik apa yang digunakan selanjutnya, apakah data berdistribusi normal 

atau tidak. Apabila penyebaran datanya normal maka akan digunakan  

statistik parametric sedangkan penyebaran tidak normal maka akan 

digunakan teknik statistik non parametik. Rumus normalitas dalam SPSS 

dengan Kolmogorov Smirnov dengan cara sebagai berikut: 

a. Buka program SPSS. 

b. Klik Variable View dan isi name dengan variabel X dan varibel Y. 

c. Klik Data View dan masukkan semua data dari kedua data tersebut. 

d. Pilih menu utama SPSS, klik Analyze dan klik 1 Sample K-S 

e. Masukkan data ke kotak sebelah kanan lalu centang normal dan 

klik Ok untuk mengakhiri perintah. 

f. Setelah selesai, maka akan muncul tampilan output SPSS dan 

diinterpretasikan. Lihat nilai signifikansi dari kedua data tersebut  

yang muncul pada hasil output SPSS, lalu bandingkan dengan nilai 

signifikan 0,05. 

Jika nilai signifikan > 0,05, maka data tersebut dinyatakan 

berdistribusi normal. 

Jika nilai signifikan < 0,05, maka data tersebut dinyatakan 

berdistribusi tidak normal. 

 

2. Uji homogenitas 

Setelah melakukan uji normalitas data yang berguna apakah data 

yang didapatkan berdistribusi normal atau tidak. Maka langkah selanjutnya 

adalah melakukan uji homogenitas data. Uji homogenitas data berguna untuk 

mengetahui data berasal dari sampel yang homogen atau tidak. Maksud 

homogen disini adalah bahwa sampel yang diambil memiliki tingkat 

kemampuan atau tingkat pemikiran yang sama atau tidak. Oleh karena itu, 

dalam uji homogenitas data ini kita menggunakan 2 sampel data untuk 

mengujinya. Rumus homogenitas dalam SPSS dengan cara sebagai berikut : 

a. Buka program SPSS. 

b. Klik Variable View dan isi name. 

c. Klik Data View dan masukkan semua data dari kedua data tersebut. 
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d. Pilih Analyze. 

e. Pilih Compare Means, selanjutnya pilih One Way ANOVA 

f. Maka akan muncul tab  One Way ANOVA lalu masukkan nilai 

variabel Y  ke dalam Dependent List, dan variabel X ke dalam 

Factor List. 

g. Kemudian pilih option, lalu beri tanda ceklis pada Homogeneity 

Of Variance Test, lalu klik continue. 

h. Lalu pilih OK 

i. Setelah selesai, maka akan muncul tampilan output SPSS dan 

diinterpretasikan. Lihat nilai signifikansi pada tabel test of 

homogeneity of Variances  yang muncul pada hasil output SPSS, 

lalu bandingkan dengan nilai signifikan 0,05. 

Jika nilai signifikan > 0,05, maka kedua data tersebut dinyatakan 

homogen. 

Jika nilai signifikan < 0,05, maka kedua data tersebut dinyatakan 

tidak homogen. 

 

3. 2 Related Samples 

Uji ini dilakukan terhadap dua sampel yang berpasangan. Sampel 

yang berpasangan diartikan sebagai sebuah sampel dengan subjek yan g sama 

namun mengalami dua perlakuan atau pengukuran I dan perlakuan II. Rumus 

2 related samples dalam SPSS dengan cara sebagai berikut : 

a. Buka program SPSS. 

b. Klik Variable View dan isi name. 

c. Klik Data View dan masukkan semua data dari kedua data 

tersebut. 

d. Pilih Analyze. 

e. Pilih Non parametric.  

f. Selanjutnya pilih Legacy Dialogs, dan pilih 2 related samples  

g. Masukkan data dari kotak kiri ke sebelah kanan, pada kotak test 

pair. 

h. Klik Wilcoxon 

i. Continue lalu OK 
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4. Uji t 

Uji ini digunakan untuk mengetahui ada atau tidaknya perbedaan 

rata-rata antara dua kelompok sampel yang tidak berhubungan. Menguji 

diterima atau ditolaknya hipotesis melaui pendekatan uji kesamaan dua rata -

rata uji dua pihak (uji t). Apabila data tersebut berdistribusi normal dan 

homogen, maka rumus yang digunakan  adalah : 

    t = 

S

nn

XX

21

21

11



 

 

5. Uji Kruskall Walllis  

Uji Kruskal Wallis adalah uji nonparametrik berbasis peringkat yang 

tujuannya untuk menentukan adakah perbedaan signifikan secara statistik 

antara dua atau lebih kelompok variabel independen pada variabel dependen 

yang berskala data numerik (interval/rasio) dan skala ordinal. Uji ini identik 

dengan Uji One Way Anova pada pengujian parametris, sehingga uji ini 

merupakan alternatif bagi uji One Way Anova apabila tidak memenuhi 

asumsi misal asumsi normalitas. Berikut langkah-langkah untuk melakukan 

uji  Kruskall Wallis :  

a. Masukkan data di atas pada SPSS. Pastikan melakukan pengkodean 

untuk kategori data. 

b. Klik menu Analyze > Nonparametric Tests > Legacy Dialogs > K 

Independent Samples. 

c. Pada kotak dialog yang mncul, masukkan variabel penjualan ke 

kotak Test Variable List. Karena kita mengelmpokkan kategori 

berdasar merk,  masukkan variabel merk ke kotak Grouping 

Variable. Pastikan pilihan Kruskal Wallis aktif. 

d. Klik menu Define Range.  Pada kotak Minimum masukkan angka 1. 

Pada kotak Minimum masukkan angka 3 (jumlah variabel kategori) 

Klik Continue. 

e. Klik OK untuk melakukan analisa Kruskal Wallis.   
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Syarat H0  diterima atau tidak berdasarkan nilai probabilitas sebagai 

berikut:  

Apabila probabilitas > 0.05 maka H0 diterima  

Apabila probabilitas < 0.05 maka H0  ditolak  

 

6. Uji Mann Whitney 

Uji Mann Whitney U Test adalah uji non parametris yang digunakan 

untuk mengetahui perbedaan median 2 kelompok bebas apabila skala 

data variabel terikatnya adalah ordinal atau interval/ratio tetapi tidak 

berdistribusi normal. 

a. Masukkan data di atas pada SPSS. Pastikan melakukan pengkodean 

untuk kategori data. 

b. Klik menu Analyze > Nonparametric Tests > Legacy Dialogs > 2 

Independent Samples. 

c. Pada kotak dialog yang mncul, masukkan variabel penjualan ke 

kotak Test Variable List. Karena kita mengelmpokkan kategori 

berdasar merk,  masukkan variabel merk ke kotak Grouping 

Variable.  

d. Klik menu Define Range.  Pada kotak Minimum masukkan angka 1. 

Pada kotak Minimum masukkan angka 2 (jumlah variabel kategori) 

Klik Continue. 

e. Klik OK untuk melakukan analisa Mann Whitney.   

Syarat H0  diterima atau tidak berdasarkan nilai probabilitas sebagai 

berikut:  

Apabila probabilitas > 0.05 maka H0 diterima  

Apabila probabilitas < 0.05 maka H0  ditolak  

 

7. Uji Duncan 

Uji Duncan adalah uji lanjutan yang dapat digunakan untuk menguji 

perbedaan di antara semua pasangan perlakuan yang mungkin tanpa 

memperhatikan jumlah perlakuan. 

a. Buka program SPSS pada Komputer, selanjutnya akan muncul data 

view. Impor data dari Excel dengan klik File > Open > Data 
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b. Selanjutnya kita akan melakukan analisis varians, klik Analyze > 

Compare means > One Way Anova. 

c. Selanjutnya kotak dialog One way anova ditampilkan. Isi Dependent 

List, dan Faktor . 

d. Masih pada kotak dialog One way anova, kali ini akan melakukan 

uji Duncan. Klik menu Post Hoc yang terletak di sebelah kanan, 

pilih uji Duncan dan Klik Continue. Apabila semua data sudah 

lengkap maka SPSS siap memproses data, klik OK.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


